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Guide du Passage de Scrivener 2 à 
Scrivener 3
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Interprétation du Guide et du 
Tutorial

Ceci n’est pas une traduction du Tutoriel interactif anglais présent dans notre 
logiciel Scrivener 3. Je me permets de l’interpréter pour vous faciliter la 
compréhension, à vous qui avez envie de vous familiariser avec Scrivener en 
français.
Cette interprétation tient compte de ma propre expérience, multiple et abondante 
depuis quatre ans, fruit de nombreuses questions des utilisatrices et utilisateurs de 
Scrivener à la suite de mes articles et des guides sur le logiciel et l’application.
J'interprète Scrivener selon la vision de celle ou celui qui a besoin d’écrire pour sa 
carrière, qui désire concevoir un livre, travailler à une thèse, rédiger des articles, des 
mémoires, des rapports, qui doit faire des recherches, accumuler les notes, des 
pages Web, de la documentation.
Pour toutes ces raisons, il faut d’abord écrire un premier jet, puis corriger le premier 
jet, enfin l’exporter en .docx pour le publier sur la plupart des plateformes 
numériques ou l’échanger pour des projets collaboratifs.
L’export peut se faire en formats numériques :

• mobi pour Amazon et l’application Kindle pour liseuse ou tablette
• ePub pour le lire sur iPad ou tablette Android.

On peut exporter le projet en un format imprimable PDF selon les besoins : envoi de 
manuscrit aux maisons d’édition traditionnelle ou dépôt de mémoire et de thèse 
d’études académiques, universitaires ou de rédactions professionnelles, 
journalistiques, juridiques, administratives.
Ici, on dit que l'on compile en plusieurs formats.
Je vous accompagne dans les premières pages du Guide de Passage et du 
Tutorial interractiv pour vous orienter à vos débuts sur la version 3 de Scrivener.
Pour aller plus loin, dans le Guide Pratique Kermen : Scrivener 3 plus simple, je 
détaille des procédures qui me semblent essentielles pour un excellent travail 
d’écriture.

Note : pour une meilleure visibilité des images d’écran, il est souhaitable de lire le 
guide sur tablette en position paysage. Vous pouvez poser la tablette à côté de votre 
ordinateur de bureau pour suivre les indications.
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Présentation du Tutoriel par son 
Auteur

Une présentation rapide est faite par l’auteur.
Le tutoriel est un projet créé sur Scrivener 2 comme la plupart des projets que nous 
avons sur nos ordinateurs.
Il faut donc l’ouvrir en cliquant sur le projet, c’est Scrivener 3 qui démarre désormais. 
Une version 2 est copiée et sauvegardée automatiquement dans le même dossier 
que le projet.

Premier fichier : Start Here (Commencer ici)

Premier dossier Tutorial (icône jaune) en trois parties :
1. Getting Familiar with the Changes (Se familiariser avec les 

changements)
2. Compile (Compiler)
3. New Features (Nouvelles fonctionnalités)

Ce dossier comprend le guide pour les utilisateurs de Scrivener 2 passant en 3.

Deuxième dossier : Draft (Brouillon)
Modèle de manuscrit de roman avec texte en latin de cuisine pour illustrer le propos. 
Ce dossier sera utilisé lors de la compilation. 
Deux séparations (partings).
Des chapitres de manuscrits.

Troisième dossier : Front Matters (Pages liminaires ou Préface)
Ce dossier sera utilisé pour la compilation avec un paramétrage créé par Keith 
Blount, son auteur, sur Scrivener 2, mis à jour lors de l’ouverture par le nouveau 
logiciel.

Quatrième dossier : Characters (Personnages)
Cinquième dossier : Places (Lieux)
Ces dossiers sont de simples dossiers avec des icônes de repérages, où vous 
pouvez stocker les fiches sur les personnages et les lieux de vos romans. 
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Sixième dossier : Research (Recherches) avec un modèle de couverture de roman.

Septième dossier : Template Sheets (Fiches de modèles)

Huitième dossier : Project Notes (Notes de projet)

Neuvième dossier : Trash (Corbeille)

Cette structure du classeur est un modèle pour un roman. Vous pouvez l’adapter 
comme vous le voulez. N’hésitez pas à circuler d’un dossier à l’autre, prenez des 
idées pour construire vos propres projets selon vos besoins.

Pour bien utiliser ce Tutorial, consultez-le dans Scrivener 3, en suivant les 
différentes pages selon leur sujet, même si vous n’êtes pas anglophone émérite. Au 
fil des pages, Keith Blount vous invite à ouvrir un panneau ou un autre endroit du 
programme.

Lors de ces exercices, il est recommandé d’ouvrir le panneau Quick Reference 
(Référence rapide) pour avoir les instructions devant vous. Il suffit de sélectionner 
un document et de cliquer sur l'icône Réf rapide de la barre de menu avec le 
carnet de notes et le crayon jaune près de l’icône Insertion avec le trombone bleu 
de bureau.

Ce mode d’affichage présente tous les éléments sur une seule page flottante que 
vous pouvez déplacer sur votre bureau. Lorsque vous êtes dans l’Éditeur, vous 
avez besoin de trois fenêtres pour les voir tous. Une fiche de synthèse est bien 
pratique.
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La page flottante se met devant votre page en cours de lecture, vous pouvez la 
déplacer où cela vous est confortable.
Pour vous assurer que la fenêtre reste flottante, allez dans :
Scrivener : Window > Float Quick Reference Panels
Scrivener : Fenêtre > Volets de référence rapide flottants
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La fenêtre se referme en cliquant sur la croix en haut à gauche.

Si vous voulez garder les deux versions de Scrivener, la 2 et la 3, cliquez sur la 
première page.
Si vous voulez utiliser seulement Scrivener 3, passez au chapitre suivant sur 
Updating Projects (Mise à jour des projets).
Et ainsi de suite, jusqu’à la fin : That’s All, Folks ! (C’est tout, les gens !)
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Utiliser les 2 versions de Scrivener

En attendant de vous familiariser avec Scrivener 3, il est prudent et rassurant de 
garder Scrivener 2 sous la main. Ils peuvent tourner tous deux sur la même machine 
et gérer différents projets sous l’un ou l’autre format.
Il faut se souvenir que les projets mis à jour en Scrivener 3 ne sont plus lisibles en 
Scrivener 2.
En raison de différentes préférences et de réglages divers, Scrivener 3 n’essaiera 
pas d’ouvrir vos projets Scrivener 2 automatiquement et Scrivener 2 ne pourra pas 
ouvrir les projets écrits sur Scrivener 3. On peut donc utiliser les deux versions l’une 
à côté de l’autre aussi longtemps qu’on en a besoin ou qu’on le souhaite.

Mise à jour du projet
Quand vous ouvrez un projet Scrivener 2 dans Scrivener 3, il vous est dit que le 
fichier sera mis à jour dans le nouveau format. 
Avant de le mettre à jour, Scrivener fera une sauvegarde de votre projet dans le 
dossier où il est enregistré. 

Note : si le projet est dans Dropbox, glissez-le d’abord sur le bureau de votre 
ordinateur et enregistrez la sauvegarde sur votre disque dur. Vous éviterez d’inutiles 
lourdeurs de synchronisation.

Exporter un projet 3 en Scrivener 2
Si vous avez besoin de partager un projet avec quelqu’un utilisant encore 
Scrivener 2, vous pouvez exporter une copie du projet dans l’ancien format en allant 
dans le menu Scrivener :
File > Export > as Scrivener 2 Project…
Fichier > Exporter comme projet Scrivener 2
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Exporter les Préférences de 
Scrivener 2

Si vous utilisez Scrivener 2, si vous avez mis au point de bons paramétrages, 
rouvrez votre logiciel d’origine et un projet abouti précédent.

Assurez-vous que Scrivener 2 est bien installé, vous pouvez le garder en parallèle 
avec Scrivener 3. Si vous l’avez supprimé de votre ordinateur, vous pouvez toujours 
le retélécharger sur le site où vous l’avez acheté.

Dans Scrivener 2, allez dans le menu Scrivener, sélectionnez Préférences 
(Preferences) cliquez sur Gérer (Manage) en bas de la fenêtre et choisissez : 
Enregistrer toutes les préférences (Save All Préférences).

Enregistrez toutes les préférences dans le dossier de votre choix sur votre disque 
dur en un fichier .prefs.
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Dans Scrivener 3, allez dans Scrivener > Préférences.
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Cliquez sur Général > Démarrage.

En bas, vous avez le menu déroulant dans :
Gérer > Charger toutes les préférences.
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Cliquez sur Charger toutes les préférences en recherchant le fichier avec 
l’extension .prefs dans le dossier choisi.
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Certaines Préférences ont changé et il faudra tenir compte des nouvelles fonctions 
pour obtenir ce que vous voulez.

Termes anglais du Tutorial

Preferences > Préférences
Manage > Gérer
Save All Preferences > Enregistrer toutes les préférences
Load All Preferences > Charger toutes les préférences
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Les Changements Visibles

Largeur de page fixe
Dans l’éditeur, la largeur est fixée par défaut, plus pratique pour formater les pages. 
La largeur fixe rend l’écriture et la lecture plus confortables.

Vous pouvez activer le mode Page View (Vue Page) en allant dans l’icône bleue de 
Présentation et descendant dans le menu à Afficher la vue Page qui vous donnera 
plus l’impression d’écrire un livre.

Vous pouvez toujours adopter le mode Plein écran ou le mode Composite.

Menu Scrivener : Présentation
> Activer le mode Plein écran 
> Activer le mode Composite.

Vous pouvez avoir l’impression que certaines fonctions ont disparu des barres de 
menu. Ne vous inquiétez pas, les menus ont été un peu « nettoyés ». Certaines 
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fonctions ont changé de place pour un usage plus intuitif.

Nouvelles fonctions dans le Menu
La fenêtre Insert (Insertion) permet d’insérer plus rapidement, des notes de bas de 
page, des commentaires, mais surtout des images. Avant, il fallait aller chercher 
dans Modifier et descendre tout en bas du menu déroulant pour trouver l’insertion 
d’images.

La fenêtre Navigate (Navigation) rassemble toutes les commandes de navigation 
de l'interface, comme Afficher dans le classeur, Aller à, Ouvrir comme 
Référence rapide, ou copyholder (Porte-copie). Dans l’Éditeur, vous pouvez 
Verrouiller l’affichage de la page, (Lock in place), etc.  Ces commandes sont plus 
accessibles qu’avant.

La fenêtre Présentation (View) permet de Montrer les titres dans Composite, 
Montrer les caractères invisibles et le Mode machine à écrire.
View > Scrivenings mode > Text Editing submenu.

Présentation (sélectionnez un dossier) > Mode Composite > Afficher les titres 
en mode composite.

Cette fonction est pratique lors de la relecture du manuscrit entier.
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Note : n’hésitez pas à fouiller les différents menus pour en voir les résultats sur votre 
page ou votre projet d’essai de Scrivener 3. Vous vous familiariserez plus vite en 
choisissant les fonctions qui vous intéressent.
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Se Familiariser avec Scrivener

Pour vous familiariser avec Scrivener 3, prenez le temps de naviguer dans les 
différentes parties, sections et sous-sections du Guide de passage de Scrivener 2 à 
Scrivener 3.

Si vous voulez continuer avec le Tutorial Interractiv, présent dans le tableau de 
bord à l’ouverture de Scrivener, j’en ai fait une introduction en français.

Si vous désirez commencer tout de suite par les modèles que je propose en 
français, vous pouvez sauter cette partie pour y revenir plus tard, si vous voulez 
approfondir certaines questions.
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Entrer dans Scrivener 3 par le 
Tutorial
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Étude du Tutorial 

Il est conseillé de commencer par le Tutorial Interractiv que vous voyez dès 
l’ouverture de Scrivener 3.
Dans le projet Tutorial, allez dans Fichier > Nouveau Projet (File > New Project), 
cliquez sur Getting Started et double-cliquez sur The Interactive Tutorial.
Dans le chapitre Get it Out there, dans Sections Types, on trouve des explications 
détaillées (en anglais).
Certes, vous ne comprendrez pas tout si vous n’êtes pas anglophone, mais en 
regardant les captures d’écran, vous commencerez à vous faire une idée. C’est en 
manipulant les fichiers, les dossiers, les documents que le cerveau enregistre les 
nouvelles fonctionnalités.
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Interractiv Tutorial 

Pour bien démarrer avec Scrivener 3, prenez le temps de regarder les vidéos 
proposées sur le site de Literature & Latte, même si vous n’êtes pas anglophone. 
Vous verrez au moins les manipulations en dynamique, vous aurez une idée de 
« comment ça marche », ce qui fait quoi, où ça change, où ça se pose, ce qui 
s’ouvre, ce qu’on peut cacher, des tas de petits trucs qui font la vraie richesse du 
logiciel.

Liens aux vidéos du site Literature & Latte

Ensuite, vous ouvrez l’Interractiv Tutorial. Ouvrez un Nouveau Projet à côté pour 
vous mettre tout de suite dans le bain.
Il y a beaucoup de texte, mais essayez de faire les manipulations proposées dans 
des phrases en bleu.

La première manipulation proposée est : File > New Project.
Dans votre Scrivener 3, allez dans la barre de menu :
Scrivener > Fichier > Nouveau Projet et commencez à utiliser le logiciel.

Vous pouvez aussi faire des manipulations directement dans le Tutorial, il existe 
une fonction de réinitialisation pour le remettre en l’état après avoir fait vos essais.

Tout en bas dans Tips : cliquer sur la flèche près de l’ampoule.

Comment utiliser le Tutorial ?
Regardez le Classeur de gauche. Vous avez plusieurs dossiers. Refermez-les tous 
avec la flèche.
Vous voyez trois dossiers essentiels que l’on ne peut pas supprimer : Draft, 
Research et Trash. Ce sont des Dossiers Spéciaux (Special Folders) 
inamovibles. 
En français : Brouillon, Recherche, Corbeille.
Vous pouvez les renommer, les déplacer, mais il est plus logique d’avoir votre travail 
dans cet ordre.

https://www.literatureandlatte.com/learn-and-support


20

Ouvrez le dossier Draft. Vous avez encore trois dossiers (il peut y en avoir d’autres 
bien sûr) : The Basics, Going Further, Tips.
En français : Les bases, Pour aller plus loin et Trucs.

The Basis (Les bases) : vous étudiez tout ce qui est nécessaire pour démarrer avec 
Scrivener. Il vaut mieux lire les chapitres dans l’ordre et cela peut prendre du temps. 
Mais ensuite, vous pouvez créer vos propres projets et utiliser Scrivener avec 
efficacité.

Going Further (Pour aller plus loin) : vous approfondissez certains outils et 
fonctions. Vous pouvez vous référer aux pages selon les besoins et il n’est pas 
indispensable de lire dans l’ordre. Ce sont des repères à conserver tant qu’on n’a 
pas la maîtrise du logiciel.

Tips (Trucs) : une sélection de petits trucs.

Si vous débutez dans Scrivener : commencez par The Basis, suivez les 
manipulations en bleu et observez ce qu’il se passe.
Quand vous vous sentez à l’aide, créez votre propre projet de test, commencez à 
écrire et revenez plus tard dans la partie Going Further (Pour aller plus loin), pour 
améliorer vos compétences.

Si vous utilisiez Scrivener 2, allez directement à What’s New ? (Quoi de neuf ?)
Dans les collections accessibles par le bouton View (Présentation) à la gauche de 
la barre Scrivener et sélectionnez Show Collections pour ouvrir la zone des 
Collections au-dessus du Draft (Brouillon).

Conseils de Keith Blount

Agrandir le texte
Si le texte vous semble trop petit dans le Tutorial, vous pouvez augmenter le 
pourcentage d’affichage.

• Soit dans la fenêtre View > Zoom In ou Out ou Cmd> et Cmd< pour 
agrandir ou réduire :
Présentation > Agrandir, réduire

• Soit en bas de la page de l’éditeur, la page du milieu dans laquelle vous 
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écrivez ou allez écrire.

Afficher le texte sous les icônes
Faire un Ctrl-clic (clic droit) dans la barre du haut, n’importe où, et un petit menu 
déroulant apparaît avec Icon and Text (Icône et texte). 

Par principe, le Tutorial utilise les Paramètres par défaut. On peut toujours les 
réinitialiser dans la fenêtre Scrivener > Préférences... 

Avant de plonger dans le Tutorial, Keith Blount recommande de cliquer sur les Key 
Concepts (Concept-Clés), dans la liste sur la gauche du classeur, au-dessus du 
Draft pour se familiariser avec les idées essentielles derrière Scrivener.
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The Basics = Les Bases

Ouvrez le dossier intitulé The Basics (Les bases).
Vous voyez la structure de cette partie, composée de trois Sections ou Chapitres. 
Il vaut mieux désormais les appeler Sections pour faciliter la compréhension de la 
Compilation finale.

Cliquez sur le titre avec l’icône jaune, The Basis.
La page de l’éditeur apparaît blanche, le titre est aussi en haut, mais pas dans la 
page. C’est une des subtilités de Scrivener qui déroute les nouveaux utilisateurs.

Note : cela n’empêchera pas le titre d’apparaître dans le document final.
Scrivener vous évite de copier plusieurs fois la même chose. Prenez tout de suite de 
bonnes habitudes. Simplifiez votre travail, vous gagnez du temps sur la création 
pure.

Quatre grands dossiers dans cette Partie The Basis
1. Get Oriented (Pour se repérer)
2. Get Organised (Pour s’organiser)
3. Get it Out There (Pour Sortir de là = Compiler le projet)
4. Get Going (Continuer)

Get Oriented (Pour se repérer)
Main Interface (Interface principale)
The Binder (Classeur) sur la gauche, le principe rappelle celui du classeur à 
anneaux où on rangeait les fiches, les chapitres et documents, en les classant par 
des intercalaires, pour créer de nouveaux dossiers.

Au milieu, the Editor (Éditeur) permet de lire toute page de texte ou toute image ou 
tout PDF rangés dans le Binder (Classeur).
C’est là que l’on écrit comme on le faisait avec les traitements de texte, où l’on peut 
faire les mises en forme d’écriture, bien qu’on puisse aussi les faire à la fin, lors de 
l’exportation du Manuscrit en un seul document, opération appelée Compilation 
dans Scrivener.
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Enfin, si vous cliquez sur l’icône bleue du « i » à droite dans la barre de menu 
Scrivener, vous faites apparaître une troisième fenêtre, celle de l’Inspecteur, 
Inspector en anglais.

Cliquez sur le document intitulé The Binder (Classeur) qui est le premier chapitre 
ou sous-section de cette Section ou Partie Get Oriented (Pour se repérer).

Note : la mise en forme et la compilation utilisent désormais le terme de Section et 
Sous-section pour les Chapitres et les Scènes, Heading pour les En-têtes de 
partie ou sections.



24

The Binder = Le Classeur

Utiliser le Classeur
C’est le principal outil de navigation du logiciel Scrivener. On l’utilise pour accéder 
aux différentes parties du projet, aussi bien pour créer de nouvelles sections que 
pour les organiser.

Note : il semble que le terme à utiliser dans Scrivener 3 soit Section, dès lors qu’on 
crée un nouveau document, que ce soit un texte avec beaucoup ou peu de texte ou 
un dossier. Tous les fichiers sont des Sections, les dossiers des En-têtes, avec 
deux niveaux, ce qui sera important au moment de la Compilation.

Il y a des manipulations à apprendre tout de suite, utilisant les ressources des 
systèmes utilisés sur les ordinateurs ou mobiles pour les appliquer à des spécificités 
Scrivener.

Le clic sur un document l’ouvre dans la fenêtre centrale intitulée l’éditeur et permet 
de le lire ou d’y écrire.
Le clic sur le triangle à côté d’un dossier ou d’un groupe permet de développer ou 
réduire son contenu (les sous-documents).
Le glisser-déposer sur un document permet d’organiser les sections (fichiers 
texte ou dossiers par chapitre) en les montant, les descendant, les déplaçant.
Un double-clic sur un document permet de le renommer, de lui donner un 
nouveau titre dans la sélection bleue qui s’affiche.
Clic+ dans le pied de page en bas du classeur permet de créer un Nouveau 
Document ou le raccourci Cmd+N.
Un clic sur le bouton d’un Dossier+ permet de créer un nouveau dossier.
Un clic sur la flèche dirigée vers le bas à côté du Bouton + dans la barre de 
menu du haut permet de créer un nouveau dossier.

On peut ajouter de nouveaux documents à partir du menu Projet de la barre de 
menu du haut. 
On peut encore ajouter une page, quand on est dans un document, en appuyant 
sur la touche Entrée du clavier. Un nouveau document se crée sous celui où vous 
étiez, vous pouvez lui donner un titre et vous mettre à écrire.
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Enfin, vous pouvez importer un Fichier dans votre classeur en les faisant glisser à 
l’endroit voulu.
Ou bien vous utilisez le menu Fichier > Importer > Fichiers...

Dossier ou Fichier
Ce qu’il faut savoir sur la notion de dossier ou de fichier.
Imaginez une feuille de carton pliée en deux qui vous servirait de dossier. Si vous 
écrivez dessus, le dossier deviendra une page de chapitre ou document et 
réciproquement, une feuille de papier pourrait servir d’intercalaire. C’est un peu 
pareil en virtuel. En fait, un dossier peut devenir un fichier et un fichier devenir un 
dossier. Cela peut se passer en cours de travail, quand vous changez d’avis, que 
finalement vous n’avez rien à ajouter à ce que vous aviez créé d’abord en dossier.

La manip : un clic droit ou Ctrl+clic sur Get Oriented dans le classeur du Tutorial 
(sous l’icône jaune The Basis)
Un menu contextuel apparaît : sélectionnez Convert to File ou Convertir en 
fichier.
Essayez, puis revenez au dossier bleu d’origine en cliquant sur Convert to Folder 
ou Convertir en dossier.

Là, vous avez déjà appris qu’en faisant un clic droit ou le raccourci Ctrl+clic vous 
faites apparaître des menus cachés, non accessibles directement dans les Menus 
du haut ou du bas. 
Vous avez accès à de plus nombreuses fonctions.
Mais rappelez-vous que vous n’êtes jamais obligé de les utiliser toutes. Le but de ce 
guide est de vous apprendre à trouver celles qui vous conviennent.

En tout cas, n’hésitez pas à user des touches Ctrl+clic ou Opt+clic, vous pouvez 
des trucs utiles. J’ai découvert le lien à Antidote par hasard de cette façon, en 
fouillant partout.
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The Editor = L’Éditeur

L’Éditeur est la fenêtre du milieu de projet, la plus grande, où l’on peut écrire 
confortablement.
On peut y afficher aussi d’autres documents que du texte, consulter un PDF ou 
écouter un fichier Audio.

Charger une image
Dans le dossier Recherche, en bas du classeur, vous avez l’image Sunset.
Cliquez sur l’image, elle s’affiche dans la fenêtre du milieu, vous ne voyez plus le 
texte que vous lisiez à l’instant.
L’image s’affiche aussi en petit dans l’Inspecteur de droite, à la place du Résumé. 
On dit qu’une image vaut mille mots, si vous avez besoin de repères visuels, vous 
pourrez mettre des images à la place de vos résumés. Libre à vous !
Revenez à la page The Editor du Binder pour poursuivre le voyage dans le 
Tutorial.

Utiliser l’Éditeur
La barre de mise en forme apparaît sous la barre de menu où vous trouvez des 
icônes de navigation et où vous pourrez plus tard ajouter des outils spécifiques à 
votre travail, comme l’icône des caractères invisibles.
Vous vous repérez dans cette barre, la même que vous utilisiez dans les anciens 
traitements de texte : styles, police, gras, taille, justification, couleur du texte, 
espacement des lignes.
On peut trouver d’autres formatages dans le menu Format du haut.

Le Menu Insert ou Insérer permet d’insérer une image, un tableau, des notes de 
bas de page, des commentaires, et autres éléments dans un texte.
Le Menu Edit ou Éditer permet de faire des Rechercher/Remplacer.
Edit > Find > Find… Édition > Rechercher > Rechercher
On reverra cette fonction plus approfondie dans la partie CORRIGER du Guide 
Scrivener 3 plus simple.

Si vous écrivez des scénarios ou des pièces de théâtre ou des bandes dessinées, 
vous pouvez entrer dans l’éditeur le format qui vous concerne.
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Format > Scriptwriting
Raccourci Cmd+8

The Header View ou Barre de menu du haut est au-dessus de l’éditeur. Vous y 
lisez le titre du document en cours auprès d’une icône de texte.
À gauche, vous avez une flèche dirigée vers la gauche. Elle vous reconduit dans le 
document précédent.

Vous avez aussi deux flèches du côté droit, vers le haut et le bas, qui vous 
permettent de naviguer d’un document à l’autre.

Les deux fenêtres permettent de diviser votre  Éditeur en deux pages pour lire deux 
documents l’un près de l’autre ou l’un au-dessus de l’autre. En travaillant sur un long 
document, on peut avoir besoin de se référer à des recherches ou à d’autres parties 
du manuscrit.
Scrivener permet de partager l’écran en deux, verticalement ou horizontalement, 
pour voir le texte en cours d’écriture dans le Draft ou Manuscrit ou Brouillon et un 
document classé dans le dossier Recherches.

Menu : View > Editor Layout > Split horizontaly
Menu : Présentation > Affichage de l’éditeur > Fractionner horizontalement
Bouton : un clic sur les deux rectangles au haut à droite de la barre de menu de 
l’éditeur permet d’y accéder plus rapidement.
Raccourci : Opt+clic sur le bouton permet de sélectionner les panneaux en 
verticale ou horizontale.

Dans la barre de menu de l’éditeur, vous pouvez aussi faire un Ctrl+clic et vous 
faites apparaître un menu déroulant qui vous propose des outils de grammaire et 
éventuellement en bas Antidote, si le correcticiel est installé sur votre ordinateur.
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Le bas de page
On y trouve à gauche l’affichage du texte des pages, au milieu le nombre de mots ou 
de caractère et sur la droite les objectifs de session d’écriture et du projet.
Le bas de page sert aussi à naviguer de page en page dans un document lu dans 
l’éditeur.
Regardez en bas du dossier Recherche, Scrivener a mis un document en PDF, 
cliquez sur spacewalk_info, le texte s’affiche dans l’éditeur, en bas à gauche, une 
page est encadrée de flèches de navigation et vous avez le nombre des pages au 
milieu.
Revenez dans l’Éditeur. À ce stade, vous devriez déjà avoir une bonne notion des 
utilisations du Binder (Classeur) et de l’Éditeur.

Maintenant, vous pouvez vous lancer dans le projet enregistré tout à l’heure au 
début de ce Tutorial pour expérimenter par vous-même.
Si vous ne l’avez pas fait : File > New Projet (Fichier > Nouveau Projet), 
choisissez Fiction ou Non-Fiction, circulez dans ces modèles, ouvrez-les, 
consultez-les, c’est ainsi que vous trouverez ce qui vous convient pour ce que vous 
avez à faire.
Si vous ne savez plus où vous êtes, cliquez sur Navigate > Reveal in Binder 
(Navigation > Afficher dans le classeur).



29

The Inspector = L’inspecteur

Si le Classeur et l’Éditeur restent assez semblables à ce qu’on a connu dans la 
version 2 de Scrivener, l’Inspecteur a changé en plusieurs fonctions.
Les boutons sont différents en haut, dans le prolongement de la barre de menu de 
l’éditeur.

1. Notes (Notes)
2. Bookmarks (Signets)
3. Metadata (Métadonnées)
4. Snapshots (Instantanés)
5. Comments & Footnotes (Commentaires et Notes de bas de page)

Lorsqu’il y a un point sur un des boutons, c’est qu’il y a du contenu dans ce 
champ. Ici on voit un point près de Metadata (Métadonnées générales), cliquez.

Le fichier a été créé le 23 août 2006 à 22 h 20 (on entre ainsi dans l’histoire de 
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Scrivener, publié la première fois en juin 2006), le projet a été modifié cette année le 
27 juin 2017 à 17 h 44.

Revenir sur le bouton Notes en haut de l’inspecteur.
On voit deux cases dans cette fenêtre, en haut Synopsis (Résumé) et en bas 
Notes.
Le haut de la fenêtre, sous Synopsis, permet de renommer le titre du document.
On peut rédiger le Résumé dans la petite fenêtre du haut et on peut prendre des 
notes ou mettre une photo, comme Keith Blount l’a fait en exemple dans ce tutoriel.

Dans les Notes, on jette toutes idées utiles pour nous lors de l’écriture ou de la 
relecture de nos manuscrits, soit des idées à développer ou des problèmes à 
corriger.

Pour les Résumés, on peut imaginer une fiche récapitulative agrafée à un texte. En 
exemple, cliquez sur le titre du Classeur : The Inspector qui contient des sous-
documents, ensuite si vous cliquez sur les quatre carrés encadrés d’orange en haut 
près de l’icône texte dans le Mode Groupe, vous voyez s’afficher les fiches des 
sous-documents de ce dossier. Ces résumés sont des fiches, des Index Cards en 
anglais.
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Labels = Étiquettes & Statuts

En Scrivener 2, les Labels et Statuts se géraient dans une des petites 

fenêtres de l’Inspecteur.

Maintenant, les Labels ou étiquettes en français, et les Status ou statuts du 

texte se gèrent dans le bas de l’Inspecteur.

Ici, le label est Blue et le statut est To Do.

Nous reviendrons sur l’utilisation plus poussée de ces fonctions qui gèrent 

la constitution et l’avancement du projet.

Pour assigner une étiquette à plusieurs documents, on les sélectionne 

dans le classeur en appuyant sur la touche Maj temporaire, puis sur Ctrl et on 

clique sur Label dans le menu déroulant.

Où l’on voit déjà l’importance des touches et des raccourcis dans la version 

3 de Scrivener.

On continue par le document intitulé Bookmarks.
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Bookmarks = Signets

Toujours dans l’Inspecteur, sur le côté gauche de votre écran Scrivener, 

cliquez sur le bouton Bookmarks ou Signets à côté de celui du Texte.

C’est l’ancien champ Références du document. Vous pouvez stocker ici des 

documents de références, présents dans le projet, sur le disque dur ou sur 

l’Internet.

Pour ajouter un nouveau signet

1. Cliquez le bouton des Options en haut de la petite fenêtre.

2. Glissez un document du Classeur depuis la liste des fichiers.

3. Glissez un document depuis le Finder dans la liste.

4. Glissez une adresse Web URL dans la liste.

Les Signets du document

Keith Blount a placé deux signets à cet endroit.

Un dans les signets du document.

Un dans les signets du projet.



33

Si vous cliquez sur l’un, le document s’affiche dans la fenêtre en bas.

Si vous double-cliquez sur l’autre, le document s’affiche dans une fenêtre 

flottante devant le projet.

Les Signets du Projet

On accède aux autres signets du projet dans la barre de menu, pour une 

navigation rapide lors de la consultation fréquente des documents.

On continue par Metadata.
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Metadata = Métadonnées

Les métadonnées de base sont inscrites dans la troisième icône comme la 

date de création et de modification.

Inclure dans la compilation : si la case est cochée, le document sera 

compilé dans le fichier compilé à la sortie. On peut l’exclure.

On le vérifie aussi dans l’éditeur en bas dans le pied de page, une petite 

icône discrète (très discrète) montre si le document est coché pour la 

compilation ou exclu de la compilation avec un x.

 

Section type ou Le type de section : c’est une partie importante de la 

compilation finale.

Avant, on cochait les sauts de page ici. Maintenant, on décide si c’est une 

section avec saut de page ou pas. Pour l'instant, on laisse la Section notée, 
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basée sur la structure (Structure-based), le logiciel va vérifier la structure des 

sous-documents et des documents pour en gérer la sortie (Output).

On changera les paramètres pour mettre nos choix dans la partie 

COMPILER.

La fenêtre du milieu permet d’ajouter des métadonnées personnalisées.

En bas, les Keywords (Mots-clés) permettent de retrouver les documents 

dans les champs de Recherche et Collections.

On appuie sur la petite roue dentée en choisissant un Label (Personnages, 

Lieux ou Themes) ou en cliquant sur +.

De même, on peut accéder aux mots-clés du projet entier.

Vous pouvez mettre des Personnages (Characters), des Lieux (Locations) 

et des Thèmes (Themes). Vous pouvez leur assigner une couleur, qui 

s’ajoutera à celle des étiquettes ou Labels.

On peut utiliser le Glisser-déposer pour mettre un mot-clé sur un 

document ou un groupe de documents.

On finit cette partie en cliquant sur Snapshots.
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Snapshots = Instantanés

La fonction Snapshots (Instantanés) permet de garder des copies des 

précédentes versions de votre manuscrit.

Utile avant de faire des modifications importantes lors de la relecture et 

des corrections.

Raccourci : Cmd+5

Menu : Document > Snapshots (Instantanés)

Bouton : appareil photo et bruit lors de la prise du cliché

L’Instantané prend en flash le document en cours.

Essayez une de ces procédures, un Instantané s’inscrit en haut de la 

fenêtre.

La liste des Instantanés se voit dans la fenêtre de l’Inspecteur sur la droite 

(cliquez sur le i bleu pour l’afficher si le troisième panneau de Scrivener n’est 

pas affiché).

En cliquant sur le bouton Snapshots, on voit la liste des Instantanés pris 

sur le projet. Le texte de la première version s’affiche dans la fenêtre d’en bas.

On peut comparer deux versions.

On peut revenir à la première version (Roll Back).

Dans le classeur, on voit quels documents ont été pris en photos, car l’icône 

texte est cornée (comme une oreille de chien, dog-eared corners, dixit Keith 

Blount).

Pour voir ce qui a changé dans le document, ajoutez une phrase et 
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supprimez DELETE ME.

Dans l’Inspecteur, sélectionnez l’Instantané que vous venez de prendre.

Cliquez sur Compare et vérifiez les changements en bleu et rouge en bas.

À vous de voir ce que vous préférez.

On continue par Comments & Footnotes.
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Comments & Footnotes = 
Commentaires Et Notes De Pied De 

Page

Le bouton des Commentaires est une petite note au bout des cinq boutons 

du haut de l’Inspecteur.

Il y a un point si ce champ présente du contenu.

Deux exercices sont proposés sur cette page :

Cliquez sur les deux textes surlignés dans les phrases en italique. On voit 

s’afficher un commentaire dans la fenêtre de l’Inspecteur à droite en haut. Et 

dessus une note de bas de page (Footnote).

Ajoutez un commentaire ou une note de bas de page 

Bouton Comments (Commentaires)

Menu : Insert > Comment (Insérer > Commentaire)

Raccourci : Maj+Cmd+8

Ajoutez du texte

Touche Entrée pour retourner au texte.

On supprime les notes en cliquant sur le signe - en haut.
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Mode Composition

Le mode Composition permet d’écrire sans distraction, en ne voyant plus que le 
texte en cours.

Bouton : Carré noir en blanc près du bouton Inspecteur
Raccourci : Opt+Cmd+F
Menu : View > Enter Composition Mode (Présentation > Passer en mode 
Composition)
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Ce mode d’écriture est calé par défaut sur un Type Machine à écrire. Vous pouvez 
le modifier dans Préférences > Édition.
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En faisant passer la souris en bas de cette page unique, vous faites apparaître un 
menu pour exécuter divers réglages de page et d’en sortir.

Vous pouvez personnaliser le décor de ce type d’écriture par une photo de votre 
choix en fond d’écran.
Menu > Projet > Project Settings
Menu > Projet > Paramètres de projet > Images de fond de page

Vous pouvez naviguer dans le Menu :
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Navigate > Go To
Navigation > Aller à.

Pour sortir du mode Composition, cliquez sur les deux flèches devenues noires 
en bas à droite.
Raccourci : Opt+Cmd+F
Escape ou Échappe.

Maintenant, après avoir vu la façon de s’orienter dans le projet, en étudiant le 
tableau de bord de Scrivener, il est temps de voir comment vous pouvez vous 
organiser dans votre travail d’écriture. Vous pouvez tester la suite du Tutorial, je 
vous ai confié les clés de la maison en quelque sorte.

La suite sera développée dans le guide Scrivener 3 plus simple.
D’ici là, travaillez bien !
Gaelle Kermen
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Glossaire Anglais-Français

Logiciel Scrivener 3

• Copyholder : porte-copie ou clip de document prés de l’écran de saisie
• Merge : fusionner deux paragraphes ou chapitres en un seul document 

ou fichier
• Layouts : Présentation ou Disposition

• Outliner : Tableau général pour vérifier les sauts de page, le nombre de 
mots de chaque scène, chapitre, section, partie.

• Split : Partage de l’écran ou Scission d’une page en chapitres.

Application iOS

Lors du passage de Scrivener 2 à Scrivener 3, l’application pour iPad et 
iPhone a été francisée.

• Split est devenu : fractionner.

• Merge est devenu : fusionner.
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Tableau de l’interface de Scrivener 
3

Les différentes parties de la présentation de Scrivener ont été mieux 

francisées. Seuls quelques menus « avancés » restent en anglais.

Barre de Menu en haut (Apple)

Barre d’Outils (personnalisables selon vos besoins)

Classeur (Binder)

Éditeur (Editor)

Inspecteur (Inspector)

En haut de l’éditeur : Barre de mise en forme (de la page d’écriture)

En bas de l’éditeur : Pied de page avec le pourcentage de l’affichage de la 

page, les infos sur le nombre de mots ou de caractères écrits et les objectifs de 

la session d’écriture.

Certaines icônes du haut ou du bas de page sont très petites et discrètes 

pour éviter de surcharger l'interface, il faut apprendre à les repérer pour bien 

s'en servir. On y trouve des merveilles pour faciliter notre travail au quotidien.
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Vers le Guide Scrivener 3 plus 
simple

Cette introduction aux tutoriels anglais fournis par Literature 1 Latte devrait vous 
familiariser avec les principales fonctions de Scrivener 3.
Ce n’est qu’un début. Vous pouvez approfondir votre formation avec le Guide 
francophone Scrivener 3 plus simple. Il est actuellement en précommande, la sortie est 
prévue le 2 février 2018

En attendant la sortie, vous trouverez des articles sur mon blog :
http://gaellekermen.net
Si vous vous abonnez dans la fenêtre de gauche, vers le bas, vous recevrez un courriel 
lors de la sortie des articles et de la publication du guide. Ne craignez pas que je vous 
submerge de courriels, je ne fais plus de lettres de Nouvelles (News Letters) depuis 
que les réseaux sociaux nous permettent de choisir nos informations. N’appréciant 
plus de voir déborder mes messageries, je me garde d’en infliger aux autres. Seuls mes 
articles de blog vous seront annoncés.
Vous pouvez aussi venir nous rejoindre sur le groupe Facebook ScrivenerFR.
Belles écritures !
Gaelle Kermen,
Kerantorec, le 19 janvier 2018

http://gaellekermen.net
https://www.facebook.com/groups/268585006981128/
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Contact

Blog Gaelle Kermen sur Scrivener
Page Amazon
Page Smashwords
Page Iggybook

Facebook
Twitter

kerantorec@icloud.com

https://gaellekermen.net/
https://www.amazon.fr/Gaelle-Kermen/e/B004F1AAY6
https://www.smashwords.com/profile/view/gaellekermen
https://gaelle-kermen.iggybook.com/fr/
https://www.facebook.com/gaellekermen
https://twitter.com/gaellekermen
mailto:kerantorec@icloud.com
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